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Wall Street Simulator Commands
The following topics are available for viewing in the Wall Street Simulator Help file:

File
Opening a New Account
Opening an Existing Account
Closing an Account

Account
Positions
Transactions
Statement
Options

Security
Editor
Extract

Tools
Splits
Trading Desk



Opening a New Account
All Wall Street Simulations begin by selecting New Account from the File Menu.    It is at this point that 
numerous account options may be specified.    These options relate to such things as the amount of cash 
provided for the simulation, the length of the simulation, the schedule of commissions to be charged by 
Larax & Co., and the type of trades allowed for your brokerage account.

The following is a step-by-step procedure for creating a New Account:

1. Select New from the File menu.
2. Specify a filename (no longer than 8 characters) plus an extension of .LXC.    If you 

specify an extension other than .LXC or you do not specify any extension, .LXC will be 
used as a default.

3. Click the OK button.
4. Enter the name under which the brokerage account will be opened.
5. Enter the amount of cash to be deposited in your brokerage account at the beginning of 

the simulation.    This amount must be at least $1 and less than $10,000,000.
6. Select a Simulation length (in days).    This specifies the time period in which trades will 

be allowed.    After the simulation period has expired, no further trading will be allowed.    
This will enable you to effectively compare the current investment results with prior 
simulations.    An unlimited length simulation may be selected by specifying a length of 
zero (0) days.

7. Click the Options button to change other account options.    Click OK to return to the New
Account window.    If you do not change any of these options, default values will be used 
for your account.    See Account Options for more information on each option.

8. Once you are done specifying all account options, click the New button.    If any of the 3 
account files (.LXC, .LXP, .LXT) already exist on your disk, you will be asked whether to 
overwrite them or not.    If you do not want to overwrite these files, click No, otherwise 
click Yes.

Once these procedures are completed, your brokerage account will be activated and ready for trading.    
Note that an error will result if all 3 account files do not reside in the same directory on your disk.



Opening an Existing Account
Open Account is used to select an existing brokerage account for trading or review.    The following is a 
step-by-step procedure for opening an existing account:

1. Select Open Account from the File menu.
2. Select or type a file name with an extension of .LXC from the file selection dialog box.    If 

you do not specify any extension, an extension of .LXC will be assumed.
3. Click the OK Button.

If an invalid account file is selected, a warning message will be displayed.    If a valid account file is 
selected, the Account Summary Window will be displayed.    Account review or trading can now take 
place.

If a brokerage account is opened on the day that the simulation is scheduled to end, a warning message 
will be displayed.    Trading is allowed on the last day of the simulation.    However, at any time following 
the end of the simulation, no trading will be allowed.    You will only be allowed to review the account.

When the simulation has ended, all open positions must be closed.    When you open your brokerage 
account after the end of the simulation for the first time, you will have the option of having all open 
positions automatically closed.    If you choose to close all open positions, you must be sure that the 
Security Information File contains the most up-to-date market prices for your open positions.



Closing an Account
Close Account is used to deactivate the brokerage account files currently in use.    At this point, the 
Account Summary Window and any other windows currently open will be closed.

Note that closing accounts is not necessary.    Wall Street Simulator will close all account files when the 
program is terminated or when another account is opened or created.    In addition, all trades are saved 
immediately upon execution, therefore, you will not lose any trades by not closing an account.



Extracting Security Information
Security information can be extracted from a standard ASCII file which is in a Comma Separated 
Variables (CSV) format.    Each of the required pieces of information is separated by a comma and each 
line is terminated with a carriage return (ASCII 13).    Ordinarily, each line represents a single security 
quotation at a point in time.    Each line should contain the following information in the following order:
 

"Symbol","Date","Last Price","Change","Open Price","High Price","Low Price","Volume","Note"

An example of a valid CSV line is as follows:

"IBM","03/15/94",58.375,-0.5,58.5,59.25,58,2542500,""

Prodigy Services' Quote Track is capable of producing such a file automatically.    When using the Quote 
Track feature, be sure to configure your download parameters to produce a CSV format file without 
headings.    You must also specify a file to store all daily security information such as QUOTES.CSV or 
QTRACK.CSV. Although it is not required, it is helpful to use an extension of .CSV for future identification.

In order to complete the extraction process, you must specify the location of your daily security 
information (CSV) file.    This file can be located in any directory on your disk.    Simply click the Select 
File... button and select the desired CSV file.

The extract process will search the CSV file that you have specified in order to find the most recent 
quotation for each security in the file.    If a security is located in the CSV file which is not in your Security 
Information File, you will be prompted whether to add the security.    Select Yes if you wish to add the new
security to your SIF.    Otherwise, click No.    You may cancel the extract process at any time by clicking 
the Cancel button.



Editing Security Information
The Security Editor is used to make changes to the Security Information File.    You may add or remove 
securities from this file or simply update the market prices for any security.

To edit security data:

1. Select Edit from the Security menu.
2. Click or Double Click on the security symbol to be updated.    The market price, security 

name, and security type for the selected symbol will appear.
3. Make changes as necessary to the market price, security name, and security type.
4. Continue with Step 2 until all desired changes are complete.

To add a security:

1. Select Edit from the Security menu.
2. Click >>>Add to enter the Add mode.    You will note that a text box labeled "New 

Symbol" will appear and several of the other controls in the window will become disabled.
3. Enter the symbol to be added in the "New Symbol" text box.
4. If desired, enter other data relating to this symbol such as price, security type, and 

security name.
5. Click the <<<Add button.    This will add the symbol to the quote list and exit the Add 

mode.    Again, you will note that the "New Symbol" text box will disappear and all other 
controls will become enabled.    If the symbol which you wanted to add already existed in 
the list, you will be alerted and returned to the Add mode.    If you wish exit the Add mode 
without adding any symbols, click the Cancel button.

To remove a security:

1. Select Edit from the Security menu.
2. Click on the security symbol to be removed.
3. Click the Remove button.    You will be warned of the action to be taken.    If do not want 

to remove the security, click Cancel, otherwise click Yes.

REMEMBER: Be sure to click the Save button in order to save your changes, when all desired changes
are complete.    If you do not wish to save any of your changes, click the Cancel button.    
If you click the Cancel button and you have made changes to the security list, you will be 
asked whether you wish to save the security list.    Answer Yes to save the changes to the
security list and exit the security editor.    Answer No to exit the security editor without 
saving any changes made.    Answer Cancel to return to the security editor.



Splits
During the normal course of business, a stock may split.    In this case, any stocks that split in which you 
currently have a position must be adjusted according to the terms of the split.    For example, say that you 
currently own 500 shares of ABC, which subsequently splits 2 shares for 1 share (2 for 1).    You will notice
that the market price will be cut in half.    Therefore, your position must be adjusted to 1,000 shares.

By using the Stock Split tool, all necessary adjustments can be made to your positions.    This can be 
accomplished as follows:

1. Select Split from the Tools menu.
2. Click on the security symbol to be split.    Only the symbols of your current positions will 

be available for splitting.
3. Click the option button next to the desired split ratio.    If the desired ratio does not appear,

click the user defined ratio option button next to the empty text boxes (see figure 2).    Fill 
in the desired split ratio.

4. Click the Split button to adjust your positions or the Cancel button if no action is to be 
taken.



Trading Desk
The following is a step-by-step procedure for executing a trade:

1. Select Trading Desk from the Tools menu.
2. Select the desired security type from the drop down list box.    All security types are 

displayed by default.
3. Select the security symbol that will be involved in the trade.    If available, the current 

market price of the selected security will be entered in the price field.    If you wish to 
execute a trade in a security that is not listed, simply type the symbol of the security.

4. Enter the number of shares that you wish to trade.    Click the maximum button to have 
the brokerage enter the maximum number of shares that can be traded.    Before you 
click the maximum button, be sure that there is data in the price field (see step 5) and you
have selected the desired transaction type (see step 6).

5. Enter the price per share of the selected security.    Note that if a price was automatically 
entered in this field, you may change it.

6. Click the option button next to the desired transaction type:
Buy Long Sell Short
Sell from Long Position Buy Back Short

7. Click the Execute button to proceed with the trade.    Click Clear to erase all entries made
and start from scratch.    Click Cancel to cancel the current trade and close the trading 
window.

8. Before the trade is executed, the brokerage will ask you to confirm your intentions.    If all 
trade data appears to be correct, click OK, otherwise click Cancel.

9. After all trades are confirmed and executed, click Cancel to close the trading window.

During the execution of all trades, the brokerage will verify your account to ensure that your trade is 
completely valid.    For example, you may not sell a security short if you already have a long position in the
same security.    Similarly, you may not buy a security when there is an open short position in your 
portfolio.    Also, how much of security that can be bought is dependent upon the amount of buying power 
you have available.



Account Options
Each brokerage account can have its own set of options that can be used to set commission rates, 
maximum amount of trades allowed, or whether the account is a margin or short account.    These options
can be set when a new account is created or after the account is established.    The following is a 
description of each option:

Margin Account - This option can be checked if you want the brokerage to allow margin 
trading.    This will allow you to purchase a security by borrowing part of the purchase 
price from the brokerage.    Currently, SEC rules state that the maximum amount that may
be borrowed is set at 50% of the purchase price.    Note that the brokerage will not allow 
you to deactivate the margin account unless you have completely repaid the margin 
balance.    Refer to the Account Summary Window to check on your margin balance.
Short Account - This option can be checked if you want to perform short trades.    Note 
that the brokerage will not allow you to deactivate the short account unless you have 
completely covered all of your short positions.    Refer to the Account Summary Window 
or the Positions Window to check on the status of your short positions.
Interest Rate on Money Market Account - This rate determines the amount of interest 
earned on uninvested funds residing in the money market account.
Broker Call Rate - This interest rate determines the interest that is charged on funds 
borrowed from the brokerage for margin purposes.
Maximum Number of Transactions - Set this option to the maximum number of 
transactions that will be allowed during the simulation.
Maximum Position in a Security - Set this option to limit the total dollar amount of a 
position in any single security.    This option helps ensure that you will be unable to devote
all of your available buying power to a single security with the intention of profiting on a 
very small price movement.
Commission - The commission schedule is divided into 2 tiers: transactions less than 
$100,000 and transactions $100,000 or greater.    Typically, brokerages offer lower 
percentages for higher dollar value transactions.

Once all account options are set as desired, you must click OK to make the changes take effect.    In 
addition, if you wish to make the current settings the default settings, click Use as Default.    This will 
cause all new accounts to be created with the default options that you have specified.    Of course, once 
the account has been created, you may change any of the account options at any time.



Viewing Account Positions
All current positions can be viewed by selecting Positions from the Account menu.    A separate window 
will appear containing all positions in the active brokerage account.    Information such as the number of 
shares owned, current market value, and unrealized gain or loss are displayed in tabular form.

All information displayed in the positions window is updated after each trade is executed or a change is 
made to the market price of a security in your portfolio.    Information relating to unrealized gains or losses 
is dependent upon the market prices contained in the security information file (SIF).    Therefore, in order 
to produce portfolio listing, it is important that the market values in the SIF are up-to-date.



Viewing Account Transactions
All account transactions can be viewed by selecting Transactions from the Account menu.    A separate 
window will appear containing all transactions related to the active brokerage account.    Information such 
as the number of shares bought or sold, transaction price, and realized gain or loss are displayed in 
tabular form.

All information displayed in the transactions window is updated after each trade is executed.



Viewing Statement of Account
A statement showing current income or loss viewed by selecting Statement from the Account menu.    A 
separate window will appear containing an income or loss statement related to the active brokerage 
account.    Information such as unrealized and realized gain or loss, interest income, and interest expense
are displayed in a clear, concise financial statement format.

Information relating to unrealized gains or losses is dependent upon the market prices contained in the 
Security Information File (SIF).    Therefore, in order to produce an accurate statement, it is important that 
the market values in the SIF are up-to-date.

Select Print to print a copy of the Statement of Account.



Copyright and License Information

Wall Street Simulator for Windows v. 1.0
Copyright © 1994 Larax Software

DISCLAIMER
Users of Wall Street Simulator must accept this disclaimer of warranty:
"Wall Street Simulator is supplied as is.    The author disclaims all warranties, expressed or implied, 
including, without limitation, the warranties of merchantability and of fitness for any purpose.    The author 
assumes no liability for damages, direct or consequential, which may result from the use of Wall Street 
Simulator."

LICENSE AGREEMENT
Wall Street Simulator is a "shareware program" and is provided at no charge to the user for evaluation.    
Feel free to share it with your friends, but please do not give it away altered or as part of another system.  
The essence of "user-supported" software is to provide personal computer users with quality software 
without high prices, and yet to provide incentive for programmers to continue to develop new products.    If
you find this program useful and find that you are using Wall Street Simulator and continue to use it after 
a reasonable trial period, you must make a registration payment of $15 per copy (plus $2.00 for shipping 
and handling; CT Residents add 6% sales tax) to Larax Software.    The registration fee will license one 
copy for use on any one computer at any one time.

Site-License arrangements may be made by contacting Larax Software at the address below or by 
CompuServe mail.

You are encouraged to pass a copy of Wall Street Simulator along to your friends for evaluation.    Please 
encourage them to register their copy if they find that they can use it.    Click here to see How to Register.

Larax Software
PO Box 606
Sherman, CT 06784 USA
CompuServe ID: 73577,115
Prodigy: GXSJ81A
America Online: LaraxSoft
Internet: 73577.115@compuserve.com



What is Shareware?
Shareware distribution gives users a chance to try software before buying it.    If you try a Shareware 
program and continue using it, you are expected to register (Click here to see How to Register)    
Individual programs differ on details -- some request registration while others require it, some specify a 
maximum trial period.    With registration, you get anything from the simple right to continue using the 
software to an updated program with printed manual.

Copyright laws apply to both Shareware and commercial software.    Shareware authors are accomplished
programmers, just like commercial authors, and the programs are of comparable quality. (In both cases, 
there are good programs and bad ones!)    The main difference is in the method of distribution. The author
specifically grants the right to copy and distribute the software, either to all and sundry or to a specific 
group. For example, some authors require written permission before a commercial disk vendor may copy 
their Shareware.

Shareware is a distribution method, not a type of software. You should find software that suits your needs 
and pocketbook, whether it's commercial or Shareware. The Shareware system makes fitting your needs 
easier, because you can try before you buy.    And because the overhead is low, prices are low also. 
Shareware has the ultimate money-back guarantee -- if you don't use the product, you don't pay for it.



Quick Start
The following procedures can be used to begin using the Wall Street Simulator:

1. Open a New Brokerage Account.    Be sure to examine the numerous Account Options
such as margin or short trading.

2. Add securities to the security information file (SIF).    Use the Security Editor to 
accomplish the SIF.    Also, if you have a comma-separated variable (CSV) file generated 
via the Prodigy Service, you may Extract information from this file and place it in the SIF.

3. Place an order at the Trading Desk.
4. View your current positions by selecting Positions from the Account menu.
5. View your current transactions by selecting Transactions from the Account menu.
6. View your income statement by selecting Statement from the Account menu.

Following these simple steps will allow you to quickly begin a simulation.    Of course, you will have to 
update your current market quotes as often as necessary so that your portfolio will be valued properly.    
Be sure to keep real market quotes on file or else the simulation will not be accurate!



How to Register
Thank you for trying Wall Street Simulator.    If you are done trying the product and you wish to continue to
use it, you are required to register it.    The registration fee is $15 per copy (plus $2.00 for shipping and 
handling).    When you register Wall Street Simulator, you will receive the following:

1. A registered copy of Wall Street Simulator
2. A printed user's manual.
3. Lifetime product support via Mail or CompuServe.    Send questions or comments to the 

address listed below or via CompuServe mail to the ID listed below.
4. Minor upgrades will be sent to you free of charge.
5. Major upgrades can be purchased at discounted prices.
6. Newsletter Participation
7. Discounts on companion "Wall Street" products when released.
8. Product release announcements.

In order to register Wall Street Simulator, you may select from either of two options:

1. Use CompuServe's Shareware Registration facility.    Type GO SWREG and use 
registration # 2838.    The registration fee will be charged to your CompuServe account 
and Larax Software will be notified of the registration.    Your registered software and 
manual will be shipped to you immediately.

- or -

2. Select Shareware Registration from the Help menu.    Fill in all information, including 
disk size, and print the order form.    (If you don't have a printer, just drop us a brief note)   
Send the order form along with check or money order payable to Larax Software to:
Larax Software
PO Box 606
Sherman, CT 06784 USA
CompuServe ID: 73577,115
Prodigy: GXSJ81A
America Online: LaraxSoft
Internet: 73577.115@compuserve.com

The registration fee is $15 per copy (plus $2.00 for shipping and handling).    Connecticut 
residents must add 6% sales tax.



Newsletter Participation
If you are a registered user (Click here to see How to Register) of Wall Street Simulator, you can have 
monumental investment decisions or your consistently profitable portfolio management acknowledged in 
Larax Software's semi-annual newsletter.    The newsletter will be sent to all other registered users of Wall
Street Simulator.

All you need to do is send us your Larax & Co. Brokerage files so that we can evaluate them and 
determine which investments are worthy of publication.    Follow these simple steps:

1. Insert a blank, formatted diskette (3.5" or 5.25"; double or high density) into your diskette 
drive.

2. Make the current directory the one in which your Larax & Co. Brokerage files reside.
3. Copy the following files:

a. <filename>.LXC (Main brokerage information file)
b. <filename>.LXT (Transaction file)
c. <filename>.LXP (Positions file)

Use the windows program manager or use the following DOS command:
COPY <filename>.LX* A:
Note: substitute <filename> with the name which you gave to your Brokerage account 
files when you created them.

4. Mail your diskette to:
Larax Software
Newsletter Submission
PO Box 606
Sherman, CT 06784 USA

5. Remember to be honest with your investments.    We will do our best to verify the results, 
but we won't be 100% certain.

Of course, if you wish, you can always send these files via CompuServe Mail to 73577,115.



ASP Ombudsman Statement

Larax Software is a member of the Association of Shareware Professionals (ASP).    The ASP wants to 
make sure that the shareware principle works for you. If you are unable to resolve a shareware-related 
problem with an ASP member by contacting the member directly, ASP may be able to help. The ASP 
Ombudsman can help you resolve a dispute or problem with an ASP member, but does not provide 
technical support for members' products.    Please write to the ASP Ombudsman at 545 Grover Road, 
Muskegon, MI 49442 or send a CompuServe message via CompuServe Mail to ASP Ombudsman 
70007,3536.



The ASP is an association for shareware authors and distributors with the general goals of educating 
shareware authors and distributors and the public, setting standards and sharing resources and 
information among members.






